Smart View — Input and Approval Procedures

Procedure Number: SV1

Procedure Type: Process

Responsible Official Title: Budget Director
Responsible Office: Budget Office
Effective Date: December 6, 2019
Updated: January 25, 2021

Below are the procedures to input into Smart View the Fixed Cost, Revenue Adjustments, and Budget Reallocations for
the upcoming fiscal year. Once Budget Requests and any moves to Central have been approved, they will be uploaded
into the system by the Budget Office. These steps apply to authorized users that have Smart View access.

If you need to update or install Smart View visit the “Smart View for Office (Oracle PBCS)” section of the budget website
at: https://inside.nku.edu/budgetoffice/forms-instructions.html then select/open the link labeled “NKU Smart View
Software Installation Work Aid” and follow the instructions.

Once the software is installed verify that the URL in “Shared Connection URL” reflects:

https://planning-a419072.pbcs.us2.oraclecloud.com/workspace/SmartViewProviders
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Smart View — Input and Approval Procedures

Otherwise, you may get a message like this when you try to connect:

Smart View

W4 Connection to Shared Services provider failed
Error message: The provider running at

e = =4 X

~ htips://planning-a419072.pbcs. us2. oradedoud. comworkspace [Smar tViewProvidersx is not

a Shared Services provider'

< Modify
current LIRL
'https: /fplanning-a419072. pbecs.us2. oradedoud. comfworkspace [Smar tViewProviders:

< Retry

Cancel

Additional suggested configuration settings:

Options

Member Options
Data Options
Advanced
Formatting

Cell Styles

Extensions

Suppress Rows
[IMo Data [ Missing
|:| Zero

|:| Mo Access
[Oinvalid
[Junderscore Characters
[Jrepeated Members
Suppress Columns
[InMo Data [ Missing
[Jzero @

[OMo Access (t)
Replacement
#MoData/Missing Label:
#MoAccess Label:
#InvalidMeaningless:
Submit Zero

Display Invalid Data

Enable Essbase Format String

|:| Use Expense Type

[JEnable Atiribute Association Processing

Mode

Cell Display

[IMavigate Without Data
[ suppress Missing Blocks

1 = Change Smart View options related to grid rows and columns.

| #FMumericZera

| #Mo Access

| #Invalid

Data

Help

Reset

oK -

Cancel

FILE: \\fileserv3.nku.edu\DepartmentsS\Budget Office\PBCS\Work Aids\Smart View Procedures (2021-01-25).docx

Page 2 of 13



Smart View — Input and Approval Procedures

Options M= = (= *

Member Options E Change grid formatting, styling and coloring options.

Data Oplions Formatting .l.:'

Advanced IUze Thousands Separator

Formatting (®) Use Cell Styles
() Use Excel Formatting

Cell Styles

Move Formatting on Operations

Extensions Preserve Hyperlinks Font
|:| Retain Numeric Formatting
Adjust Column Width and Row Height
Scale |Default | - |
Preview | |
Decimal Places |2 | A |
Preview | L |
Form i)
Repeat Member Labels

Help Reset oK - Cancel

To save any changes make be sure to use the
drop-down (=) option next to the “OK” button:

Save as Default Options

Apply to All Sheets
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Procedures to Access Smart View and the Budget Adjustment Form

Open Excel, click on the “Smart View” tab.

<Click> “Panel” in the far left-hand corner.

<Click> “Shared Connections” in the far right-hand corner.
Select the Company Sign in option (if requested).

1.
2.
3.
4.
5.

Input your NKU username and password and <click> the “Sign In” button.
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Select the drop down next to the “Select Server to Proceed” field (reference screen shot below).
<Click> “EPM Cloud” (reference screen shot below).

<Click> on the + next to “planning-a-419072.pbcs.us2.oraclecloud.com”.

<Click> on the + next to “NKU” (reference screen shot below).

10 <Click> on the + next to “Library” (reference screen shot below).

11. <Click> on the + next to “Budget Adjustment Forms” (reference screen shot below).

12. <Double-Click> the form you want to work on, most users will see only 1 form.
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Use this form for Revenue Adjustments, Fixed Cost Adjustments, and Budget Reallocations

13. Revenue adjustments and the corresponding expense must net to zero - use the Revenue Adjustments column

Increase revenue by -$1,500
and then increase the
expense line by $1,500 where
that revenue will be spent.

Decrease revenue by $1,500
and then decrease the
expense line by -$1,500
showing that expenditure is
being reduced.

Revenue Adjustment Example (Increase)

Final Revised Revenue Adjustments Proposed Budget

Budget Budget

FY20 FY21

Jul Jul

Fee 4XXXXX -5,000 -1,500
Fee 4XXXXX -3,000

Expense S5XXXXX 8,000 1,500

Total 0 0

Revenue Adjustment Example (Decrease)

Final Revised Revenue Adjustments

Budget Budget

FY20 Fy21

Jul Jul

Fee 4XXXXX -5,000 1,500
Fee 4XXXXX -3,000

Expense 5XXXXX 8,000 -1,500

Total 0 0

Budget
FY21
Jul

-6,500
-3,000
9,500

Proposed Budget
Budget

Fy21

Jul

-3,500
-3,000
6,500

14. Fixed cost adjustments - use the Fixed Cost Adjustment column, to input the increase or decrease.

Increase fixed cost by $1,500.

Decrease fixed cost by $1,500.

Fixed Cost Adjustment Example (Increase)

Final Revised Fixed Cost Adjustment Proposed Budget

Budget Budget

FY20 FY21

Jul Jul

Expense S5XXXXX 8,000 1,500
Total 8,000 1,500

Fixed Cost Adjustment Example (Decrease)

Final Revised Fixed Cost Adjustment

Budget Budget

FY20 FY21

Jul Jul

Expense 5XXXXX 8,000 -1,500
Total 8,000 -1,500

Budget

Fy21

Jul

9,500

9,500

Proposed Budget
Budget

Fy21

Jul

6,500

6,500
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15. To move expense budgets from where they were budgeted in the current FY to where they will be expended in
the next FY to best support student success - use the Budget Reallocation column. For clarification, do not take
budget out of Student Hourly IWS, Student Stipend, Social Security, Social Security Medicare and Fringe Benefit
Reserved; the Budget Office will verify that has not occurred. If it has been decided that your budget plan does
not include contracting someone over the next fiscal year you can move funds from Contract Service lines into
the lines where expenditures will occur including Student Hourly and Student Stipend.

Budget Reallocation Example (Decrease/Increase - whole)
Final Revised Budget Reallocation Proposed Budget

Decrease budget where Budget Budget Budget

expenditure has been by - FY20 FY21 FY21

$8,000, increase the line Jul Jul Jul
where the expenditure will

be spent by $8,000. Expense SXXXXX 8,000 -8,000 0

Expense S5XXXXX 10,000 8,000 18,000

Total 18,000 0 18,000

Budget Reallocation Example (Decrease/Increase - partial)
Final Revised Budget Reallocation Proposed Budget

Decrease a portion of the Budget Budget Budget

budget where expenditure FY20 FY21 FY21

has been by -$5,000, increase Jul Jul Jul

the line where the

expenditure will be spent by Expense SXXXXX 8,000 -5,000 3,000

$5,000. Expense S5XXXXX 10,000 5,000 15,000
Total 18,000 0 18,000

Input Instructions

16. Identify the fields for FY21 that are pale yellow (indicates available for entry), that is where you enter the dollar
amount of any
adjustments listed above.

17. Enter the amount of the
adjustment, press [Enter].
The field will change from
a pale yellow to a
goldenrod yellow
denoting that this amount
is waiting to be submitted
(saved). If you need to
remove an amount,
instead of deleting it —
replace it with a zero.

bt sttt e i s
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18. Insert a comment with your explanation/justification. Add a comment by <clicking> on the field/cell that
contains a new entry, so that it is outlined. While it is still outlined, <right-click>, select “Smart View” at the
bottom of the menu, then select “Cell Comments”. Alternate method — hover over the field of entry and a menu

Increases in fixed costs represent one of the largest components of our anticipated increases in mandatory

will appear where you can select comments.

expenses. Please keep this in mind when determining your projections and consider all ways to keep fixed costs
to a minimum.

| D | E _ = G H _ I | J !
1 | Final Final Revised  Fixed Cost Adjustments Revenue Adjustments Reallocations to Central Budget Reque%
2 | Actual Budget Budget Budget Budget Budget
3 | FY20 FY21 FY22 FY22 Fr22 FY22 3
4 | YearTotal Jul Jul Tl Tl Jul $
8 Travel Pool(550900) 0.00 4,685.00 0.01 Tshoma «|10 v A" A" § v 9% 9 [5] .00 u.r§
9 |Emp TravelDomestic(550914) 1,040.09 800.00 0.0l g .50 .0 00 0.
10 |Ed/Train/Reg/Fees(550930) 1,334.00 0. : .00 0.
11 | Suppliesoffice(550005) 224.86 | -400.001 0.00 0.00 0.
12 |Tech Equip/Sftwr<500(550057) 460.00 0. 0o Cut 0.00 0.
13 Printing(550205) 234.20 150.00 0.01 0.00 0.0¢
14 Postage(550305) 0.00 10.00 0.00 [ Copy 0.00 0.6¢
15 |TelephonelLong Dist(550505) 5.91 5.00 0.0 . 0.00 0.0}
16 |Dues/Cert Lic Fees(550540) 0.00 90.00 o] LD PesteOptions: 0.00 0.
17 |Comp Eqp $500$4999(551015) 0.00 500.00 0.01 |;:31/ = 0.00 0'§
18 |Laptp/Tblt$500-$4999 (551017) 1,185.35 0.00 0.01 = 0.00 0.08
19 TelephonelLine Chrg(552610) 182.60 204.00 0.01 Paste Special... 0.00 0.6
20 |TelephoneMaint(552615) 269.50 325.00 0.01 0.00 0.00
21 |Site LicSoftware(552745) 52,920.00 70,560.00 0.0 © Smart Lookup 0.00 0.6,
22 | Auxiliary Miscellane(449990) 0.00 -2,300,000.00 0.01 0.00 0.0}
23 |AdminStaff Pool(501100) 0.00 1,489,275.00 0.01 0.00 0.3
24 |Payroll Lapse Offset(501198) 0.00 -1,000,000.00 0.01 0.00 0.
25 StaffReserve Clrg(501199) 0.00  304,735.00 0.01 0.00 0.
26 |FacultySalary(503005) 0.00 1,086,842.00 0.01 Clear Contents 0.00 0.6%
27 FacultyReserve Clrg(503399) 0.00 3,679,433.00 0.01 0.00 0.0}
28 InsHealth(522125) 0.00 1,651,976.00 00 & o 0.00 O.lé
29 |RetirementKy(522130) 0.00 -1,000,000.00 0.01 ! 0.00 0.
30 |Fringe BeneReserved(522199) 0.00 1,663,530.00 o.0of  Filter % 0.00 0.0}
31 Benefit Lapse Offset(520005) 0.00 -1,000,000.00 0.01 Sort > 0.00 0.q
32 |Miscellaneous(550899) 0.00  230,562.00 0.01 0.00 0.
33 ReserveRevenue Shar(552605) 0.00 -7,217,265.00 0.0 0.00 U.é
34 Reserved Expend(552705) 0.00  477,602.00 0.01 A 5
35 Reserved Expend(552705) 0.00  250,000.00 0.01 3] New Comment Yy Drill-through I3
36 |Student Fee Waiver(560420 0.00 -2,000,000.00 0.00 =
37 Nonmn Trf To UCFE(&G(BIU)ID) 516,234.00 0.00 0.0 L9 NewNote a L] Cell Comments EE‘
38 Nonmn Tfr Fr UcfAUX(830020)  -1,350,568.00 -1,350,570.00 0.0! [ Format Cels.. Z Supporting Details
39 -53,076,477.49 -59,755,001.00 & R ]
40 Pick From Drop-down List... s Cell Attachment %
41 - ,
2 89 Cell History %
43 | - B Lock H
44 ?
45 | m Smart View > Adjust > }
46 | j
A=l ; : - @ Undeo

Sheetl | Sheet ©) 5 t

Ready [@ 8= Options... {
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19. To create a comment, select the green + sign, type the comment, <click> the save icon (looks like a disk) and

close.
Comments o= = =+ - m} X
Location: No_Location, Project: No_Project
[G11- Unvestretd Curr Fund (0111000100), m =]
User Date Entered |
Comments m = =4 - a
Location: No_Location, Project: No_Project
| G11 - Unrestretd Curr Fund (0111000100), Institutional _ | B
User Date Entered Remmqoﬁicesuppﬁesassoddedwﬁ\&edcoslsﬂtataembngamdedi
I
- | Comments m = =+ - m} X
Hide Intersecti{
Location: No_Location, Project: No_Project
| G11- Unrestretd Curr Fund (0111000100), Insttutional ~| |G 3
User Date Entered
wolemmank 1@nk.... | 1/7/21 9:06 PM Re&lmg office WPECS associated with fixed costs that are
i no longer needed.

Hide Intersection [~ Apply to all selected cells

Close |

A

That field/cell should now be outlined with a blue border indicating that a comment is attached.

e

9 Emp TravelDomestic(550914) 1,040.09 800.00 T 00 3 E
10 Ed/Train/Reg/Fees(550930) 1,334.00 750.00 0.00
11 |SuppliesOffice(550005) 224.86 800.00| -400.00
12 Tech Equip/Sftwr<500(550057) 460.00 0.00 0.00 }
13 Printing(550205) 234.20 150.00 0.00
}:LPosta 550305 " 0.00 10.00 0.00 ’

20. Once you completed your update(s), on the “Planning” tab, click “Submit Data”. The field will return to a pale

yellow, indicating that it is available for additional updates to that field/cell.

File Home Insert  Draw Page Layout Formulas ~ Data  Review  View  Add-ins  Sm{i§
.J‘?: @)(D — “’3 Cell Actions ~ #] Adjust ~ E Morev ] Save %5 Approvals
- — & Lock ®, Drill-through "= Clear 3 Copy Version
Analyze | Refresh = POV
= B Calculate~ | BB Submit Data B &* Apply ~
Ad Hoc Data Formatting Workflow

FILE: \\fileserv3.nku.edu\DepartmentsS\Budget Office\PBCS\Work Aids\Smart View Procedures (2021-01-25).docx

Page 9 of 13



Smart View — Input and Approval Procedures

Additional Smart View Information

The new version of Smart View (20.200) added functionality for Flex Forms. Users can now more easily freeze
rows/columns, add filters, insert rows, and sort.

ta Review View Developer AoSmart View Hel

% Help ~
7

The image to the right shows
how you can verify the version of
Smart View currently installed on
your system.

. LContents
tions

#. Technical Support
=}

il 1zl 2l Y % B E

.1

@ Documentation

Health Check

i} About(z)...

Oracle Smart View for Office

ORACLE’

Oracle Smart View for Office

Wersion:

To install the updated version of
Smart View go to the
Forms/Instructions page on the
Budget Office website. Then
select “NKU Smart View
Software Installation Work Aid”
which will walk you through
installing the Smart View
software step-by-step.

20,200 (Build 182) ]

Build Date: Dec 11 2020 16:55:19.

“opyright {c) 2004, 2020, Orade andjor its affiiates. Orade and Java are registered trademarks A
of Oracle andjor its affiliates. Other names may be trademarks of their respective owners,

This software and related documentation are provided under a license agreement containing
restrictions on use and disdosure and are protected by intellectual property laws. Except as
expressly permitted in your license agreement or allowed by law, you may not use, copy,
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish,
or display any part, in any form, or by any means. Reverse engineering, disassembly, or
decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be
error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone
licensing it on behalf of the 1U.5. Government, then the following notice is applicable:

LI.S. GOVERNMENT EMD USERS: Orade programs (induding any operating system, integrated
software, any programs embedded installed or activated on delivered hardware, and
-

ot o B O S S

Enable Add-in

Version Info.. oK

To FREEZE Rows/Columns to Retain Helpful Labels

First, select the cell that represents the intersection you want to freeze (I5 in the example below). Then navigate to
View>Freeze Panes>Freeze Panes (see example below):

File Home Insert Draw Page Layout Formulas Data View Developer Add-ins Smart View Help Planning Power Pivot 1 =
1l v
‘Z’ B Page Layout ! Formula Bar C)\ Ij% é RS ESPM ' (?')=‘j F-
Arrange All Hide - =
2 P.;gr:“BI::k [ Custom Views ~ Gridlines + Headings Zeomplivs Zo * F“u:p‘m, | b Wui‘:z‘:r«:»' Mairo:
Sheet View Workbook Views Show Zoom Hﬂ Freeze Panes
T " - - BED TOWS columns visible while the rest of
= D AutoSave (8 0H) B |9~ v [% d:: el A~ D~ E v - E 2l Alﬂ ihcpcrl hcetsccl F:c on current selection).
5 . £ 0 Freeze Top Row
Freeze First Column
D E F G H 1 ] K ’ﬁﬁ Keep the first column visible while scrolling
Final Final Final Final Fixed Cost Revenue Budget Propoé through the rest of the worksheet. x
1 Revised I dj 1 Budget
2| Actual Actual Actual Budget  Budget Budget Budget Budget Shared Connections @G -»
3| FY19 FY20 Fr21 Fr21 FY22 Fr22 Fr22 Fr22 — -
4 YearTotal YearTotal YearTotal Jul Jul Jul Jul Jul | EPM Cloud |7 5 -
5 ITmel Pool{550900) 0.00 0.00 0.00 4,685.00| 0.00] 0.00 0.00 4,685.00 2 .
6 |Emp TravelDomestic(550914) 0.00  1,040.09 0.00  800.00 0.00 0.00 0.00 800.00 =& planning-2415072.pbes.us2.oradedoud.com - A
7 |Ed/Train/Reg/Fees(550930) 0.00 1,334.00 0.00  750.00 0.00 0.00 0.00 750.00 o i
8 | SuppliesOffice(550005) 286.88  224.86 0.00  800.00 0.00 0.00 0.00 800.00 -4 “‘]";‘;w .
9 |Tech Equip/Sftwr<S00(550057) 0.00 460.00 0.00 0.00 0.00 0.00 0.00 0.00 . 1 ACol
10 |Furniture/Equip <500(550058) 0.00 0.00 1,151.11 0.00 0.00 0.00 0.00 0.00 LYY Affairs [06]
11 | Printing{550205) 460.20 234.20 0.00 150.00 0.00 0.00 0.00 150.00 ) AA Accelerated Online (AOL) F
12 | Postage(550305) 0.00 0.00 0.00 10.00 0.00 0.00 0.00 10.00 S AA Colege of Arts and Scence
13 |TelephoneLong Dist{550505) 9.40 5.91 0.00 5.00 0.00 0.00 0.00 5.00 51 A& College of Business [0605]
14 |Dues/Cert Lic Fees(550540) 0.00 0.00 0.00 90.00 0.00 0.00 0.00 90.00 T A& College of Education [0610
15 |Comp Eqp $500$4999(551015) 0.00 0.00 0.00  500.00 0.00 0.00 0.00 500.00 1 AA College of Health and Hum.
16 |Laptp/Thits500-$4999 (551017) 0.00 1,185.35 0.00 0.00 0.00 0.00 0.00 0.00 T A College of Informatics [061
17 TelephoneLine Chrg(552610) 201.60 182.60 85.25 204.00 0.00 0.00 0.00 204.00 1 AA Colege of Law [0607]
18 TelephoneMaint(552615) 131.40 269.50 135.50 325.00 0.00 0.00 0.00 325.00 13 AA EM Enroliment Managemen
LAA cra PO T e o L e L L
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To ADD Filters to a Form

First, select the Row that is immediately above the data section (Row 4 in example below) then navigate to Data>Filter
and <click> on the “Filter” button. You will now see filter drop-down arrows that can be used to reduce the # rows
displayed:

File Home Insert Draw Page Layout Foomna Review View Developer Add-ins Smart View
] R) [7] Queries & Connections A \% g
E% 2C =N Y s :
Refresh Organization Stocks  |= z Filter §f Textto =
Data e % Al [ g A & Advanced Columns €& ~ ra }
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools §
B D Asve@) B DOC ¥ RBG BE Ave 20 BN YV “at
D4 ~ b
% i
i D E F G H 1 ] K L }
[ Final Final Final Final Fixed Cost ~ Revenue Budget Proposed &
1| Revised  Adjustments Adjustments Reallocations Budget z
21 Actual Actual Actual Budget  Budget Budget Budget Budget
3 | FY19 FY20 Fr21 Fr21 FY22 FY22 P22 Fy22
4 : i l
5 T (550900) i
6 |Emp TravelDomestic(550914) 0.00 1,040.09 0.00 800.00 0.00 0.00 0.00 800.00
7 IEd.’T rain/Reg/Fees(550930) 0.00 1,334.00 0.00 750.00 0.00 0.00 0.00 750.00
8 ‘Suppliesofﬁoe{SSDDDSJ 286.88 224.86 0.00 800.00 0.00 0.00 0.00 800.00
9 | Tech Equip/Sftwr<500(550057) 0.00 460.00 0.00 0.00 0.00 0.00 0.00 0.00
10 ‘;Furnl‘turelEqulp <500(550058) 0.00 0.00 1,151.11 0.00 0.00 0.00 0.00 0.00
11 Printing(550205) 460.20 234.20 0.00 150.00 0.00 0.00 0.00 150.00
12 |Postage(550305) 0.00 0.00 0.00 10.00 0.00 0.00 0.00 10.00 2
13 TelephoneLong Dist(550505) 9.40 5.91 0.00 5.00 0.00 0.00 0.00 5.00 ;}
14 |Dues/Cert Lic Fees(550540) 0.00 0.00 0.00 90.00 0.00 0.00 0.00 90.00
15 |Comp Eqp $500$4999(551015) 0.00 0.00 0.00 500.00 0.00 0.00 0.00 500.00
16 .Laptprrhlusoo-mg (551017) 0.00 1,185.35 0.00 0.00 0.00 0.00 0.00 0.00
17 Telephoneline Chrg(552610) 201.60 182.60 85.25 204.00 0.00 0.00 0.00 204.00
18 TelephoneMaint(552615) 131.40 269.50 135.50 325.00 0.00 0.00 0.00 325.00

Adding a Row for New Budget Line (Commitment Item)

To add a line for a new Commitment Item:
1. <right-click> the row you want to copy.
2. <click>on “Copy”.

A B C D E F G H 1 1 K
Final Fied Cost  Revenue Budget
1 Final Final Final Revised Ady
2 Actual  Actual  Actual  Budget  Budget Budget Budget
3| Fr19 Fr20 P21 P21 P22 Fr22 Fr22
4 o YearTotal YearTotal YearTotal Jul ul ul ul
5 Tahoma /10« AT A" § ~ % 9 2 ‘the Dean (123456785)  Institutional Support (0600) Travel Pool(550900) 0.00 0.00 0.00  4,685.00 0.00 0.00
6 B I = A% £« [theDean(123456783) Institutional Support (0600) Emp Tmmmesuc(mlﬂ 0.00  1,040.00 0.00 80000 0.00 0.00
7 —— the Dean (123456789 m:uomls 550930 0.00 1,334.00 0.00 _ 750.00 0.00 0,00
8 Darnctonsd roe comdtny 11000100 9) 28688 224.86 .00 800.00 0.000 0.000
A Cut [11000100) Office of the Dean (123456789) mmmonnl smpon(osoo) Tech Equp,rsﬂ\ur:soqssom) 0.00  460.00 0.00 0.00 0.00 0.00
|11000100) Office of the Dean (123456789)  Institutional Support (0600) Furniture/Equip <500(550058) 0.00 0.00 1,15L11 0.00 0.00 0.00
|11000100) Office of the Dean (123456789)  Institutional Support (0600) Printing(550205) 460.20  234.20 0.00  150.00 0.00 0.00
12 [} pasteOptions:  |11000100) Office of the Dean (123456769)  Institutional Support (0600) Postage(550305) 0.00 0.00 0.00  10.00 0.00 0.00
13 {11000100) Office of the Dean (123456789)  Institutional Support (0600) TelephoneLong Dist(550505) 9.40 5.91 0.00 5.00 0.00 0.00
14 3 111000100) Office of the Dean (123456769)  Institutional Support (0600) Dues/Cert Lic Fees{550540) 0.00 0.00 0.00  90.00 0.00 0.00
15 ¥ |11000100) Office of the Dean (123456789)  Institutional Support (0600) Comp Eqp $50044999(551015) 0.00 0.00 0.00 50000 0.00 0.00
16 Paste Special..  [11000100) Office of the Dean (123456769)  Institutional Support (0600) Laptp/Thit$500-$4999 (551017) 0.00 1,185.35 0.00 0.00 0.00 0.00
17 |11000100) Office of the Dean (123456789)  Institutional Support (0600) TelephaneLine Chrg(552610) 201.60  182.60 8525  204.00 0.00 0.00
18 Insert |11000100) Office of the Dean (123456789)  Institutional Support (0600) TelephoneMaint(552615) 13140  269.50 13550  325.00 0.00 0.00
19 Delets 1,089.48 493651 1,371.86 8,319.00
20
21 Clear Coptents
n
23 B Format Cells...
:; Bow Height...
26 Hide
27
28 Unhide
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Smart View — Input and Approval Procedures

3. Repeat Step 1 by <right-clicking> the row then select or <click> “Insert Copied
Cells”. You should now see an identical row.

Tahoma +[10 « A" A" § ~ C’/%
BIZ=OvA-vH9T

UITESU LY LUl FunuiuLLiuuul

fﬁ Paste Options:

(™ copy i
1
e
3

4. In one of the cells enter the desired Commitment Item number.
5. <Click> on the “Smart View” ribbon. fl"] @3 ﬁr @* @ [qu'{
6. <Click>on the “Refresh” button. Paste Special... >3
7. The line will now show the new Commitment Item and is ready for data a . g
Insert Copied Cells l
entry. I
Delete %‘
Clear Contents g""
Format Cells... %
Row Height... g
Hide f
Unhide 1
Final Final Final Final Revised Fixed Cost Adjustments Revenue
Actual  Actual  Actual Budget Budget Budget
FY19 FY20 FY21 FY21 FY22 FY22
YearTotal YearTotal YearTotal Jul Jul Jul
pport (0600) Travel Pool(550900) 0.00 0.00 0.00  4,685.00 0.00 {
pport (0600) Emp TravelDomestic(550914) 0.00 1,040.09 0.00 800.00 0.00 l
pport (0600) Ed/Train/Reg/Fees(550930) 0.00 1,334.00 0.00 750.00 0.00 :
ppo 0) SuppliesOffice(550005) 286.88  224.86 0.00 800.00 0.00 ?
ppm'?»soozo 286.88  224.86 0.00 800.00 0.00 }
ppoi ) Tech Equip/Sftwr<500(550057) 0.00  460.00 0.00 0.00 0.00 ?
pport (0600) 1Fu ut Fm Data Review View Dev-;loae-rh W g fJ
pport (0600) Pri _— 0.00
pport( g D§ ? Help ~ 0.00 }
Pport ( = _-.;% Sheet Info { 0.00 3
pport ( Submit | Options _ 0.00
pport (0600) Co Data i More 0.00 3
pport (0600) La 0.00 ¢
pport (0600) Telephoneline C} Final _ Final _ Final __ Final Revised Fixed Cost Adjustments Revenue)
pport (0600) Telephonemlnq Actual  Actual  Actual  Budget Budget Budget
FY19 Fr20 Fr21 Fr21 Fr22 FY22 }
YearTotal YearTotal YearTotal Jul Jul Jul
Travel Pool(550900) 0.00 0.00 0.00 4,685.00 0.00 1
Emp TravelDomestic(550914) 0.00 1,040.09 0.00 800.00 0.00 :
Ed/Train/Reg/Fees(550930) 0.00 750.00 0.00 !
nplie i = m m g
z 0.00 0.00 0.00 ]
"0C 0.00 0.00 0.00 f’
Furniture/Equip <500(550058) 0.00 0.00 1,151.11 0.00 0.00
Printing(550205) 460.20 234.20 0.00 150.00 0.00
Postage(550305) 0.00 0.00 0.00 10.00 0.00
Telephonelong Dist(550505) 9.40 5.91 0.00 5.00 0.00
Dues/Cert Lic Fees(550540) 0.00 0.00 0.00 90.00 0.00 }
Comp Eqp $500$4999(551015) 0.00 0.00 0.00 500.00 0.00 {
Laptp/Tblt$500-$4999 (551017) 0.00 1,185.35 0.00 0.00 0.00
0600) TelephoneLine Chrg(552610) 201.60 182.60  85.25 204.00 0.00
D600) TelephoneMaint(552615) 131.40  269.50  135.50 325.00 0.00
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Smart View — Input and Approval Procedures

Procedures to APPROVE Data Input into Smart View

WO N R WNRE

[N
N O

13.

Open Excel, click on the “Smart View” tab.
<Click> on “Panel” located near the far left-hand corner.
<Click> “Shared Connections” located near the far right-hand corner.

<Click> on Company Sign in box (depending on configuration this may not appear).

Enter your NKU username and password.
<Click> the “Sign In” button.

Select the drop-down menu next to the field that says, “Select Server to proceed”.

Choose the EMP Cloud option.
Click on the + next to “planning-a419072.pbcs.us2.oraclecloud.com”.

. Click on the + next to NKU (reference screen shot below)
. Click on the + next to Task List (reference screen shot below)

Double-click the FY21 Fixed Cost Adjustment Approval task, this will open the report. If all looks correct, have the
appropriate VP or Dean click the words, “Mark Complete”. The task will have a strike-through denoting the task is
completed. If changes are needed, the Budget Officer will make them in the Budget Adjustment Form which will feed

over to the read-only Approval Form with only the changes.

Double-click the FY21 Revenue Adjustment Approval task, this will open the report. If all looks correct, click the
words, “Mark Complete”. The task will have a strike-through denoting the task is completed. If changes are needed,
the Budget Officer will make them in the Budget Adjustment Form which will feed over to the read-only Approval

Form with only the changes.

EPM Cloud

planning-a419072.pbcs.us 2. oradedoud. com
Sl NKU

F¥20 Fixed Cost Adjustments Approval

-~ () :1.0 Approve the Fixed Cost Adjustments:

[f_'] Library
=[] Task Lists

------ Ff 20 Fixed Cost Adjustments Approval

------ F20 Revenue Adjustment Approval
‘gt REvVExXp

- Report

‘i Comp

“h# Student
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